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General Information...
          Pro Pick was designed to provide an easy and fun way to track the NFL season.    The only work you
really need to do, is enter the scores when the weekly results are in.    The last game of the week is 
normally the Monday night contest.

          The program provides several ways to view and print schedules, statistics and produces predictions 
for the upcoming week.    When a week is completed, check the 'Weekly Results' report to see how the 
teams (and Pro Pick) did. 
 
          If you received your copy of this program after the season has begun, it will be necessary to enter 
the scores for the past weeks to get the program up to date so the current statistics and predictions can 
be produced. This version of Pro Pick comes ready to use for the 1996 season. I will try and make the 
schedule and statistics available on America Online and Compuserve for years after 1996, so check 
around before deciding to take the time to enter the schedule yourself. 

          Please take a couple of minutes and read the information for each of the other topics, this should 
provide you with knowledge needed to get the most out of Pro Pick.    Note the Info buttons provided 
throughout the program.    These link to the appropriate help text for each of the programs functions.    
Look for an info button whenever you need help while using Pro Pick. 



Entering the Scores...
All scores must be entered for a given week before they can be recorded.    The last game of the week is 
normally the Monday night game.    Once the scores are entered, be sure to click on the Record button 
to save the information to disk.    

After the scores are entered, it is recommended that you print the latest statistics, predictions for the 
upcoming week and the results for the past week.    This should provide a good basis to use in preparing 
for the next week.

If there are problems with the schedule...
If a game is not played or you discover a problem with the schedule, it is best to cancel entering the 
scores and edit the schedule to correct the problem.    It will then be necessary to reenter the scores from 
the week BEFORE, then proceed as usual.    

It is necessary to reenter the scores for the week prior to the week in which a schedule problem was 
encountered because the predictions for the next week are produced when the scores are entered.    If the
schedule is changed, the predictions would not match the schedule. If a score is entered incorrectly, it will 
be necessary to reenter the scores for that week.

If an error is discovered that occurred several weeks ago, use the Edit Statistics feature to correct the 
Won, Loss and Points Scored and Points Allowed values for the two teams involved.    Load and correct 
the statistics for the most current week.

          If a team has a key injury or you wish to alter a computer quality rating (CQR) for any reason, use 
the statistics editor on the most current week of statistics before entering the scores for the next week, so 
the changes will be reflected in the predictions for the next week.    If the scores have already been 
entered and you still want to institute a change in the next weeks predictions, it will be necessary to 
reenter the scores for the last week. 

Statistics Note: The Average Offense and Defense numbers for each team are calculated using the 
current season totals along with the results from last season through week #3.    Beginning with week #4 
the averages will be calculated using results from the current season only.



Reports & Statistics…

Choose View Statistics from the Games Menu to check the latest stats.    The teams can be sorted by 
CQR which is the Computer Quality Rating, best offense, best defense or Won/Loss percentage. As the 
season progresses, the statistics will become available for each week played immediately after the scores
are entered.
Statistics Note: The Average Offense and Defense numbers for each team are calculated using the 
current season totals along with the results from last season through week #3.    Beginning with week #4 
the averages will be calculated using results from the current season only.

The Predictions Menu can be found under the Games Menu.    Select the number of the most recent 
week to view the ProPick predictions for the upcoming week.    The winner of each game will be predicted 
along with the over/under value which is the expected total score of the game.    The third ToolBar icon 
(football going through goal posts) is the quickest way to access the predictions for the upcoming week.

The CQR rating is the basis for ProPick predictions.    If you want to change this rating, choose Weekly 
Statistics from the Edit Menu.    Click on the Information button on that window for further instructions.

Choose Weekly Results to view how well ProPick did in estimating the winners and points for past 
weeks.    The predictions will be displayed along with the actual score of the game.    The number and 
percentage of games predicted correctly will be displayed at the bottom of the list.

Results for a Specific Team are also available under the Games Menu.    This will prove to be interesting 
as the season progresses.    Viewing the information in this manner can show trends where a team is 
performing better or worse than expected.

Click on the fourth ToolBar icon (Sports Page) to display the Team Standings.    This is the familiar listing 
of the teams ranked according to Won/Loss percentage within their own division.

 



Program Settings...
The reactivity value determines how quickly the program changes the team quality ratings when 

the scores are recorded.    

If this number is too low, the program will be slow when reacting to team trends.    If the number is
too high, the program may overreact and change team ratings too much in only a couple of games.

The Off / Def Weighting factor controls the degree of influence these statistics have on the 
predictions.    Generally, the higher the Off / Def factor, the larger the predicted spread will be.    

Courier New is the default printer font for Windows 3.1 and Windows 95.    Select a monospaced
font to assure that the columns are aligned properly.    Windows 3.0 users can try Roman 12 CPI or Sans 
Serif 10 CPI.    Courier and other fonts that list the characters per inch (CPI)size are monospaced. 

Do not alter the year number or create a file for the next season until the scores have been 
entered for the last week and the play-offs are over! 



Program Registration...
Registering your copy of Pro Pick will enable printing of all Statistics, Results, Schedules, Standings and 
Predictions.    Most people will want to print the forms at the beginning of the season and after the scores 
are entered each week to review the results and prepare for the upcoming week.    

Please send $10.00 to:
                        Conan L. Brown
                        9424 S. 250 E.
                        Hamlet, Indiana 46532    
        
Click Here to display a form which can be printed to make registering easier, or see Program Registration'
under the file menu to print an order form.    With a low Registration fee of only $10.00, Pro Pick is an 
excellent value. Here are just a few of the reasons.... 

We intend on making updates available each year on the Net and communication    services.

Your registration code will be valid on any future version.

You can edit the Statistics as you see fit or adjust ratings in the event of a key injury. 

Pro Pick generates & prints a complete set of nicely formatted reports each week. 

Statistics can be sorted several ways. 

Individual team schedules and the results for any team can be displayed for the entire season. 

You can adjust the Reactivity and Weighting rates to control the Rating changes and    predictions. 

And Last but not least, you will be supporting the SHAREWARE concept which helps us all to obtain a 
wide variety of software at very reasonable costs.    



Play Off & Single Game Predictions...
To Generate Predictions, Click on the Names of the Teams you want predictions for.    Use the Reverse 
button to change the team which will be considered the home team if necessary. Click on the Neutral Site 
Check box if neither team will be the home team. When the message box on the lower left contains the 
proper information, click on the Predict Button to add the teams to the list and make a prediction.    

Add as many games as needed to the list.    It may be necessary to scroll the list box sideways to see the 
complete prediction.    These predictions can be printed as a report if your copy of Pro Pick has been 
registered.    Use the Clear or Remove buttons to erase unwanted lines.    

The Selections are made using the Statistics for the last week in which the scores have been recorded.    
Do not Change the year number for the next season until the Play-Offs are over.



Project Season Winners...
The predictions are based on the quality ratings (CQR) value.    As the season progresses the latest 
statistics will be used.    Since the    predictions are not based on the teams won/loss percentage, the 
teams participating in the Play-offs may not be the same as those listed. The real intent here is to provide 
an 'early' season projection. 



Viewing Results by Team
This feature displays the results for each game played by the selected team for the current season.    To 
Select a team, use the drop-down menu and click on a team name. Click on the 'OK' button to display the 
results. To cancel and exit, click on the 'OK' button without selecting a team. 



Tool Bar Operation...
Counting from the left, the first Icon (Two Helmets) will display the entire schedule. Choosing 'View Entire 
Season' from the Schedules Menu will produce the same result.    

The Second Icon (ScoreBoard) calls up the weekly score entry window so the results from the past week 
can be entered.    The effect is the same as choosing 'Enter Scores' from the Games Menu, except that 
Pro Pick will select the proper week automatically.    Note:    When the scores are entered the week 
number is logged so the program knows which week number will be next for score entry, predictions and 
the most current statistics. If you reenter scores out of order (for an earlier week), it may cause the 
program to suggest the incorrect week number when the ToolBar is used.    This situation will be corrected
when you enter the scores for the latest week played.    Manually select the right week from the menu 
choices.

The Third Icon (Goal Post) calls up the Predictions for the upcoming week.    Again, the program will try to 
determine the proper week number.    The effect is the same as choosing Predictions from the Games 
menu.

The Fourth Icon (Sports Page) will display the League Standings.    This is the familiar listing which is 
similar to the Standings from your local newspaper.    

The Fifth Icon (Question Mark) displays this Help Window.    Info buttons throughout the program link to 
other information topics here.



Entering a New Schedule
This version is ready for the 1996 season.    If you want to prepare for another year, follow the 

instructions below.    The NFL schedule is traditionally available the week after the NFL draft has been 
completed.

Be sure to wait until the play-offs are over, and then change the working year in the (File menu) 
SETTINGS section before entering a new Schedule. The Schedule can be entered one week at a time, 
type the number of the week to be entered in the box located at the upper right.    

Click on the team names to add them to the message box.    After the two desired teams are listed
in the    message box, click on the button corresponding to the day of the week in which the game will be 
played (usually Sunday).    Click on the ADD Button to add the game to the list.    

When all games for the week have been added, click on the save button to write the Schedule to 
disk.    To continue adding other weeks, click on    the clear button and reset the Week number and begin 
adding games as described above.

If you make a mistake or the schedule is altered, click on the LOAD button to recall a week and 
make the necessary changes and re-save.    



Editing Team Names and Locations...
This feature was included to make the program usable in future years even if one or more teams 

relocate or change names.    If a team simply relocates, it will only be necessary to enter the new city 
name.    

If the teams realign, it gets a little more complicated.    The statistics are saved in a specific order. 
Get a printout of the latest ratings before beginning.    Edit the names as necessary and save the settings. 
Then, from the Edit menu, choose Edit weekly Statistics and load the last week recorded (week 17 or 
18) at the end of the season.    Finally, step through the teams checking the Team ratings and correcting 
any that need editing.    Re-save the file to keep the corrected statistics.



Play by the Rules...
A word about Sports Gambling...

This program is not to be used in violation of any Law.    By using Pro Pick you accept the 
responsibility for knowing and acting within all Local, State and Federal regulations that apply in your 
situation.    In short, if it isn't legal for you to use Pro Pick,    Don't!

Pro Pick was designed to provide an easy and fun way to track the NFL season. 

WE TRUST THAT NO ONE WILL ACT FOOLISHLY AND BEGIN BETTING OR ESCALATE THEIR WAGERS 
BECAUSE OF THIS PROGRAM. 

Thank you for using Pro Pick, we hope you have as much fun with it as we had in putting it together.            
CB



Registration Form    
 --    Choose Print Topic from the File menu to Print this form

Pro Pick v1.96

Please write your name and address below.

Name ______________________________________________

Address ____________________________________________

City, State, Zip _______________________________________

My copy of Pro Pick was obtained from ________________________

Please enclose a check from a U.S. bank or money order for $10.00 to...

Conan L. Brown
9424 S.    250 E.
Hamlet, Indiana 46532

Additional offer....

For a fun way to make your Lottery selections, try Lotto PC for Windows.    The program can be 
configured for any game including POWERBALL type Lotteries.    Lotto PC features a futuristic 3-D 
graphic look.    Actual Lottery results can be tracked.    Bar and Line graphs plus a HOT / DUE list show 
the trends.    Serious players can generate biased selections based on past results and use the Number 
Wheeling feature.    The settings for the games you play are added to the menus making the program 
customized for your area.

Lotto PC supplied on 3 1/2 disk      cost $10.00    




